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SUMMARY 
 
 The ChromImage flatbed scanner densitometer with Galaxie-TLC 
software has been used for quantification of silica gel high-performance 
thin-layer chromatography (HPTLC). The visible mode was evaluated by 
determination of the recovery of a rhodamine B standard dye from a four-
dye mixture and by determination of the precision of replicate analysis. 
Determinations of caffeine in multicomponent analgesic tablets and a cola 
beverage were performed in the fluorescence-quenching mode. Previously 
published methods for the tablet and beverage analyses were modified by 
using HPTLC plates with a brilliant ultraviolet indicator, and analysis of 
the beverage was further modified by automated application of standard 
and sample bands by use of a Linomat. Accuracy, precision, linearity, and 
sensitivity of these analyses with the ChromImage are reported. 
 
INTRODUCTION 
 
 We have previously reported [1] use of an office flatbed scanner 
modified in-house for documentation and quantification of thin layer 
chromatograms detected by fluorescence quenching on silica gel layers 
containing an ultraviolet (UV) indicator. Since that work, the ChromImage 
has become available from AR2i (Le Plessis Robinson, France). This in-
strument, which, as far as we are aware, is the first commercial flatbed 
scanner densitometer, enables acquisition of TLC plate images and quanti-
fication of chromatograms by use of Galaxie-TLC software. 
 We tested the ChromImage for determination of a rhodamine B in 
a four-dye mixture at two concentrations on silica gel high-performance 
thin-layer chromatography (HPTLC) plates using the visible mode (white 
light source of the scanner). It was used with the 254 nm UV source, in
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conjunction with modifications of previously-published procedures, for 
determination of caffeine in multicomponent extra-strength analgesic ta-
blets [2] and in a cola beverage, without sample preparation [3]. Both de-
terminations were modified by use of an HPTLC plate (Adamant) contai-
ning a brilliant UV indicator. Analysis of the beverage was further mo-
dernized by automated, spray-on band application of standard and sample 
solutions by use of a Linomat rather than manual application with a 
micropipet. 
 
EXPERIMENTAL 
 
Recovery of Rhodamine B Standard 
 

 The performance of the ChromImage in the visible mode was eva-
luated by determining the recovery of Rhodamine B from a four-dye mix-
ture by use of an approach suggested by Aborashed [4]. HPTLC was per-
formed on 20 cm × 10 cm silica gel 60F254 GLP plates (EMD Chemicals, 
Gibbstown, NJ, USA, an affiliate of Merck, Darmstadt, Germany; #5613/6), 
which were used as received. Test Dye Mixture I solution (Analtech, 
Newark, DE, USA), containing 4.00 mg mL−1 each of fast green FCF (aqua 
blue), rhodamine B (red), Bismark brown Y (yellow), and Sudan IV (vio-
let-pink), was diluted to 0.175 mg mL−1 (standard S1) and 0.250 mg mL−1 
(standard S2) with methanol. Five different volumes of S1 (2.00, 4.00, 
6.00, 8.00, and 10.0 µL; 0.350–1.75 µg) were applied to produce the cali-
bration plot, and duplicate 3.00-µL and 5.00-µL volumes were applied as 
‘unknown samples’. Sample zones were applied by use of a Linomat IV 
automated spray-on band applicator (Camag, Wilmington, NC, USA) fitted 
with a 100-µL syringe and operated with the settings: band length 6 mm, 
application rate 4 s µL−1, table speed 10 mm s−1, distance between bands 
4 mm, distance from the bottom of the plate 1.0 cm, tracks 5–13 spotted. 
The plate was developed to 8 cm beyond the origin with ethyl acetate–
methanol–water, 80:20:20, in the front trough of a Camag twin-trough 
chamber saturated with mobile phase vapor (saturation pad in the back 
trough). The plate was dried in a fume hood after development, scanned, 
and the rhodamine B was quantified by use of the ChromImage. 
 

Determination of Caffeine in Analgesic Tablets 
 

 Caffeine standard was purchased from Aldrich (St Louis, MO, 
USA; #C0750) and a standard solution (0.100 mg mL−1) was prepared in 
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methanol. To prepare a sample stock solution an extra-strength analgesic 
tablet with a label declaration of 65 mg caffeine, 250 mg acetaminophen, 
and 250 mg acetylsalicylic acid was ground to a fine powder with a mortar 
and pestle, the powder was transferred to a 100-mL volumetric flask by 
washing with approximately 70 mL methanol, and the mixture was stirred 
magnetically for 30 min. The stir bar was removed by use of a magnetic 
rod and the solution was diluted to volume with methanol and mixed by 
shaking. Undissolved excipients were removed by filtration through a Pall 
Gelman (Ann Arbor, MI, USA) Acrodisc LC 13 mm syringe filter, with a 
0.45 µm PVDF membrane, into a capped vial. To prepare the TLC test 
solution from the sample the clear sample stock solution was diluted 1:10 
by mixing 100 µL sample stock solution with 900 µL methanol. Digital 
Drummond (Broomall, PA, USA) microdispensers (100 and 1000 µL) we-
re used to measure volumes. 
 A Nano-Adamant UV254 silica gel HPTLC plate (Macherey–Nagel, 
Easton, PA, USA; #821 120) was prewashed by development to the top 
with 1:1 dichloromethane–methanol, dried, and spotted on tracks 7–12 
with 2.00, 4.00, 6.00, and 8.00 µL standard solution (0.200–0.800 µg caf-
feine) and duplicate 6.00-µL volumes of the sample solution (theoretically 
0.390 µg, on the basis of the label declaration) by means of the Linomat 
with the settings listed above. The plate was developed in a saturated twin-
trough chamber with ethyl acetate–glacial acetic acid, 95:5, as mobile 
phase, dried, and scanned and quantified with the ChromImage, using the 
254-nm source. 
 The limits of detection (LOD) and quantification (LOQ) of caffei-
ne were determined by spotting decreasing amounts of standard solution 
until the zone could no longer be detected by eye under 254-nm light in a 
Camag UV cabinet (LOD) or by use of the densitometer (LOQ). 
 

Determination of Caffeine in a Beverage 
 

 The same volumes of the same caffeine standard solution were 
applied to a prewashed Adamant UV254 HPTLC plate by use of the Lino-
mat, with four replicate 4.00-µL volumes of cola beverage that had pre-
viously been decarbonated by sonication (tracks 4–11). The initial standard 
and sample zones were placed further apart (6 mm instead of 4 mm) and 
the rate of application was reduced to 15 s µL−1 for the beverage. After ap-
plication, the plate was dried for 5 min at 100°C on a Camag plate heater. 
The plate was predeveloped with methanol to a position 1 cm above the 
origin, dried for 2–3 min at 100°C on the plate heater, then developed to a 
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distance of 6 cm with ethyl acetate–methanol, 19:1, in a saturated twin-
trough chamber. The plate was dried and then scanned and quantified with 
the ChromImage, using the 254 nm UV source. 
 
Operation of the ChromImage Scanner and the Galaxie-TLC Software 
 

 The procedures described below are adapted and amplified from 
the TLC Plug In User’s Guide received with the ChromImage and the 
Help section of the Galaxie software; these procedures were used through-
out this research. 
 
Scanning a Plate 
 

 The plate was placed face down on the scanner to fit the standard 
positioning cover (covers of three standard plate sizes were supplied with 
the instrument – 100 × 100, 100 × 200, and 200 × 200 mm2). The knob at 
the back of the scanner was switched to either UVC (for ultraviolet C 
light, 254 nm) or VIS (for visible light) depending on the mode of scanning 
required for the plate. In the Plug-ins menu of the main Galaxie window, 
TLC was selected. In the pop-up window, the Acquire menu was selected 
from the File menu, and in the next screen acquisition conditions, for 
example wavelength, sample number, deposit front distance, etc., were 
entered. When all fields were filled, OK was selected to proceed to the 
Twain Acquisition window and Acquire was selected to initiate scanning. 
After the plate had been saved in the Galaxie database, as an .IEV file, 
Export To Diamir was selected from the Picture Processing menu as 
either Automatic or Manual Selection. Automatic Selection was selected 
for images of Linomat-spotted, unchanneled plates. When the lanes were 
defined the Send button was selected, then OK on the Information window 
that pops up listing all chromatograms created from the plate. 
 
Chromatogram Processing 
 

 In the main Galaxie window, the Open tab was selected to open 
the chromatogram wanted. In the Data menu, the Chromatogram Proper-
ties menu was selected, then the Variables tab, and the solvent-front 
distance in centimeters was entered in the DISTANCE_SOLVANT [sic] 
field. The Integrate button at the top of the main window was selected to 
obtain the retardation factors for all peaks automatically defined by the 
software. These retardation factors would not be correct, however, because, 
by default, the migration distance of a zone from the bottom of the plate 
(instead of from the origin) is divided by the solvent front distance. To 
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obtain the correct RF values the formula for the retardation factor must be 
changed manually every time a new chromatogram is being processed. 
This was done by selecting Results in the Data menu and in the table 
under the chromatogram right-clicking on the Retardation_f column. Edit 
Variable RETARDATION FACTOR was selected in the pop-up menu. In 
the Edit Only RETARDATION FACTOR window, the default formula for 
the retardation factor is RT/DISTANCE_SOLVANT, where RT is the 
retention time displayed on the x-axis. 
 [Note: Because Galaxie-TLC was adapted from software conceived 
for column liquid and gas chromatography, the name of the x-axis was 
apparently not changed from retention time, as in column chromatography, 
to migration distance, as is usual in TLC densitograms, even though the 
numbers on the x-axis correspond to centimeters on the plate. Thus, RT is 
the distance (cm) the zone traveled from the bottom of the plate (in the 
table of peak data below each chromatogram, these distances are also listed 
in centimeters, although the unit given in the table is mm).] 
 The formula was edited by subtracting the distance of the origin 
from the bottom of the plate (1.0 cm in this research) from the RT: 
(RT − 1.0)/DISTANCE_SOLVANT. Apply and OK were selected to close 
the window, then Integrate in the main Galaxie window to obtain the 
recalculated RF values. 
 Peaks were then defined/deleted. Each unwanted peak was deleted 
by right-clicking on the peak and selecting Peak/Delete. If automatic inte-
gration had not defined the peaks of interest correctly, the peaks were re-
defined manually by selecting the Move Marker Mode icon and clicking 
and dragging the Start/Stop Peak and Start/Stop Baseline markers. When 
all peaks of interest had been defined, Reprocess was selected from the 
Processing menu to reprocess the chromatogram and save the changes. 
Before reprocessing, Integration in the Options tab was deselected, because 
otherwise all deleted peaks reappeared after reprocessing. This procedure 
was repeated for all the chromatograms on a plate. 
 
Creating a Calibration Method 
 

 In the main Galaxie window, all the chromatograms were opened. 
For one of the chromatograms of the standards, Calibration in the Method 
menu was selected. The calibration method was configured by selecting 
External Standard as the calibration type and Area as the Response. ug 
was typed in as the Standard Unit and Level number was set to the num-
ber of standard aliquots (e.g. 4). Initialize from ID tables was selected to 

 - 254 -



 

import the defined peaks and enter the weights of the standards. After the 
calibration method had been configured, the method was saved under the 
name of the plate. 
 
Calibration, and Interpolation of the Weights of the Unknowns 
 

 For each chromatogram, Reprocess was selected from the Proces-
sing menu. Under Method File the name of the calibration method was 
entered. For chromatograms of standards, the level of the standard (e.g. 
Standard Level 1) was selected under Calibration/Level. Integration in the 
Options tab was deselected and the chromatogram was reprocessed. For 
chromatograms of the unknowns, Unknown was left as the calibration le-
vel to obtain the weight of the sample after reprocessing. By default, the 
weights of the unknowns were interpolated from the first-order polynomial 
calibration curve that was forced through zero. To view the calibration 
curve and change the settings, the Calibration tab was selected in the 
lower left corner of the screen, Open/Open Calibration Curve was selected 
from the File menu, and the calibration curve was chosen by selecting the 
calibration method name. When the calibration curve file is opened the re-
gression coefficient and the equation can be viewed under Results. Below 
the Results section, the Polynomial Order was set to 2 and the Force 
Through (0,0) option was deselected. In the Calibration Points table it 
was possible to uncheck the points in the Used column to exclude the 
points not wanted in the calibration curve. The regression coefficient and 
the equation were recalculated automatically. The calibration curve was 
saved and the reprocessing procedure was followed for the chromatograms 
of the unknowns to interpolate the weights from the saved calibration plot. 
 
RESULTS 
 
Recovery of Rhodamine B Standard 
 

 Figure 1 shows a densitogram obtained from the test dye mixture 
in the visible mode. The calibration plot (peak area against amount (µg) 
applied) for S1 was 0.999 using polynomial (second order) regression. The 
theoretical weights in the duplicate aliquots of S2 were 0.750 and 1.25 µg 
for 3.00 and 5.00 µL samples, respectively, and the mean recoveries after 
interpolation of the experimental weights were, respectively, 102 and 105% 
of the amount taken. These values were within the acceptance criteria for 
TLC procedures of the International Conference on Harmonization (ICH) 
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for accuracy of assay, content uniformity, and dissolution testing in phar-
maceutical analysis [5]. They are also comparable with results for recovery 
of parthenolide standard by visible-mode slit-scanning densitometry re-
ported elsewhere (97.3–106%) [4]. The differences between interpolated 
weights of duplicate aliquots of S2 were both 0%, because identical weights 
were obtained; this is indicative of good analytical precision. 
 

 
 
Fig. 1 
 

Densitogram produced by the Galaxie-TLC software after separation of the dyes in Test 
Dye Mixture 1: F, fast green FCF (RF 0.08); R, rhodamine B (0.33); B, Bismark brown Y 
(0.70); S, Sudan IV (0.78). A small impurity peak is seen between F and R. 4.00 µL of a 
1.00 mg mL−1 solution was spotted for illustrative purposes; the solution spotted for 
quantification was more dilute, and the top two zones were too light to be photographed 

 
 To further assess precision, 6.00 µL S1 (1.05 µg) was spotted on 
each of tracks 5–13. The relative standard deviation (RSD) of the zone 
areas measured by the Galaxie-TLC software was 1.45%. 
 
Determination of Caffeine in Analgesic Tablets 
 

 The calibration plot for caffeine had an r-value of 0.999 (second-
order regression). Mean recovery of caffeine from the tablet was 100% of 
the theoretical (label) value, and the difference between interpolated weights 
in duplicate sample aliquots was 0.512%. When 4.00 µL volumes of stan-
dard solution (0.400 µg) were spotted on 15 of the 18 tracks available 
across the plate (tracks 3–17; Fig. 2), the RSD of the peak areas after de-
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velopment was 1.66%. The LOD was found to be 0.100 µg and the LOQ 
0.150 µg. These results are indicative of good linearity, accuracy, precision, 
and sensitivity for assay of caffeine in the tablet by use of the ChromImage. 
 

 
Fig. 2 
 

Chromatograms produced by the ChromImage and used for analysis of caffeine in an 
analgesic tablet. SF, solvent front; O, origin; C, caffeine (RF 0.27); A, acetaminophen 
(0.50); AC, acetylsalicylic acid (0.55). Lanes 1–4, 2.00–8.00 µL standard solution; lanes 
5 and 6, duplicate 6.00-µL aliquots of sample solution. The zones are outlined because at 
the levels used for quantification they would not be readily visible after the plate image is 
reduced for publication 

 
Determination of Caffeine in a Beverage 
 

 After predevelopment and analytical development as described in 
the experimental section, the RF value of caffeine was 0.34; other zones 
were seen in the chromatograms at RF 0.14 and 0.56, because other 
ingredients in the beverage absorb UV light and quench the fluorescence 
of the UV indicator. The r-value of the calibration plot was again 0.999 
for second-order regression (Fig. 3). The mean weight of caffeine inter-
polated from the calibration plot for the four 4.00-µL volumes of cola was 
0.399 µg, representing recovery of 98.8% relative to the value reported in 
the literature (36.0 mg per 12 ounces) [6]. The RSD of the four sample 
weights interpolated from the calibration plot was 2.50%. These data are 
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again indicative of good accuracy and precision for use of the ChromIma-
ge in the 254 nm UV mode. 
 

 
 

Fig. 3 
 

Calibration plot for caffeine produced by the Galaxie-TLC software. The second-order 
regression equation was y = 115.85x2 + 4419.10x − 324.87 

 
DISCUSSION 
 
 In addition to the flatbed scanner used in this research, other types 
of densitometer are commercially available, including slit scanning densi-
tometers, photodiode-array detectors, video cameras (CCD), and digital 
cameras [7]. Most quantitative TLC analysis reported in the literature has 
involved use of slit scanning densitometers which enable each lane to be 
scanned with monochromatic light of the optimum wavelength and spectra 
of separated zones to be acquired; these are regarded as providing the 
highest quality quantitative results. The analytical and validation results 
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obtained with the ChromImage in this study, however, compare favorably 
with slit scanner results for recovery of a standard in the visible mode [4] 
and with UV-mode determination of caffeine in the same analgesic tablets 
[2]. The results for caffeine in the beverage were superior to those obtained 
by use of an early double-beam fiber-optic densitometer (Kontes, Vineland, 
NJ, USA) [3]. All accuracy (comparison with known values), precision 
(repeatability), linearity, and sensitivity values obtained with the Chrom-
Image for the visible and UV-mode analyses were consistent with recog-
nized validation guidelines for pharmaceutical analysis by TLC. 
 The Galaxie-TLC software gives densitograms with relative peak 
height on the y-axis and RT (retention time, min) on the x-axis (Fig. 1). 
Peak areas rather than heights were used in all the analysis reported in this 
paper. Densitograms of fluorescence-quenched zones were less smooth than 
that shown for colored zones in Fig. 1, but they were adequate for quanti-
fication using the manual integration approach described above. 
 Analysis was performed using the external standard method. First-
order (linear) and second-order (polynomial) calibration were compared, 
and second-order without forcing through 0.0 resulted in superior accuracy 
and precision in all our analyses. 
 According to the manufacturer, the Adamant plate contains an en-
hanced UV indicator, a new and improved binding system, and a harder, 
abrasion-resistant layer. It was chosen for maximum brightness when illu-
minated by the 254 nm ChromImage source. 
 Caffeine was determined in the beverage without the need for sam-
ple extraction or cleanup. We found that direct application of the aqueous 
beverage with the Linomat was successful if an application rate of 15 s 
µL−1 was used, rather than the 4 s µL−1 rate normally used for standards 
and samples dissolved in organic solvents such as ethanol or methanol. It 
was found that up to 15 µL of the beverage can be applied as a compact 
band if this is necessary for the amount of caffeine to be bracketed within 
the calibration plot. There have been no previous descriptions in the lite-
rature of the conditions needed for direct application of beverage samples 
using the Linomat. Predevelopment for 1 cm with methanol served to 
further concentrate the initial zones obtained from 4.00 µL beverage be-
fore analytical development. It is likely that Linomat application to a plate 
with a concentration (preadsorbent) zone would obviate the need for the 
focusing predevelopment. 
 In summary, we have shown that the new ChromImage scanner 
densitometer gave good quantitative results in the visible and fluorescen-
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ce-quenching modes. We have also modified previously-reported analyses 
for assay of an analgesic tablet and a beverage by use of a plate with en-
hanced UV indicator and use of automated spotting. 
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